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Word Handout - Week Three (3/4/19) 
 

Two of the most useful things you can do in Word are to create Envelopes and Labels and to work with 
Tables.  They are very much related as you can use a table to create labels. 

 
Tables 

 
Word - All Versions - A table is a group of rows and columns that are neatly arranged for editing and 

sorting.  An example for use might be a list of names and address.   
 
An easy way to create a table is: 

1. Type the names of the column headings, separated by tabs or commas.   
2. Then highlight the list you made 
3. Click on Table in the Insert Ribbon, under Table 
4. Then click on Convert-Text to Table.   
5. Pick the delimiter you decided to use (tab or comma) and then click OK.    
6. It should give you a small table. 

 
Example - type the following: 
 
First Name, Last Name, Address, City, State, Zip 
 
Highlight the above and perform the steps that were itemized.  It will yield the following.   
 

First Name Last Name Address City State Zip 

 
This table has six columns that are all the same width.  As you enter data it may be necessary to adjust 
the width - Address needs more space and State and Zip may need less.  The tab key jumps you from 
cell to cell and hitting tab from the last box in the last row will add an additional row.  It is also possible to 
add rows by using the Table, Insert, Rows from the menu.  Hitting the enter key goes to the next line in 
the same cell.  Also when creating a table you can let the title determine the column width and then 
expand as needed. 
 
If you put the cursor in the table, the column widths show on the ruler at the top.  Adjustment can be 
made to the width by grabbing the spacer (when the double arrow shows) and moving it.  When adjusting 
width, start with the columns you wish to shrink.  Then expand the ones that need to be wider.  Text can 
be made to automatically wrap (default) or to fix to cell.  Switch is found under table properties. 
 
Tables can be sorted by any column(s).  When a table is sorted, every column is automatically included 
in the sort.  (This is different from sorting in Excel)  If a table overflows to several pages, you can print 
headers on each page by checking the appropriate entry from the Table Menu.  When sorting be sure to 
tell the sort function whether or not you have a header row so that row isn’t included in the sort.  Sorting 
tools are revealed in a ribbon call Table Tools when the table is highlighted 
 
2007 and later - The method described above can be used to create a table in version 2007 and later.  
Remember, the Convert Text to Table command is found on the ribbon that is revealed by the Insert tab.  
Click this tab, find the table section and click the down arrow. 
 
Word 2007 and later gives you a couple of easier options to use versus earlier version of Word.  You can 
create a blank table just by highlighting the boxes that appear under the Table Section.  Rather than 
describe them all, I think you will see they are fairly easy to use. 
 
An additional feature of 2007 and later is that when you want to change the font in a table (or in any 
document, for that matter), you can hover over the highlighted text or table and you will see a ghosted 
format menu.  Clicking on it  will solidify that menu and give you choices.  In the case of a table it will give 
you a chance to add rows or columns and play with cell alignment.  Sort is found in the Layout Tab, which 
only appears if the table is highlighted. 
 



2 

 

When creating a table from text you can specify the delimiter character, such as a comma, tab or 
paragraph marker and also the width of each column.  Sometimes it is easiest to let the width be dictated 
by text and then adjust the width later.  Revealing the ruler by finding the box in the View Tab allows for 
easy adjustment.  Address, for example, needs a wider column than a two-character state abbreviation.  
It is also easier to reduce the width where appropriate to create space for increasing width. 
 
Envelopes and Labels 
 
2007 and later - In these versions of Word there is a Mailings tab.  Choosing this tab will expose several, 
self-explanatory options.  At the left in the Create section is where you would make a single envelope or a 
set of return address labels. 
 
To print directly on envelopes (typically a #10, business envelope) you need to have a printer with a 
special feed that will handle envelopes.  Often it is easier to print addresses on labels and stick them on 
the envelope.  White or clear labels are available (Avery # 8257, 5160 or 8160).  Return address labels 
are Avery #5267 or 8167).  Always check the number printed on the packages as the same product 
measurement can sometimes be referenced by more than one number. 
 
Return Address Labels 
 
To print a page of return address labels, Choose Labels from the Mailing.  This will open a smaller 
window with the choice of "Full page of the same label", which is what you'd want for this application.  
Then under options find Avery #5267 - 80 labels per page. Enter the desired name and address in the 
little window.  Then create New Document.  If font, centering, etc are not to your liking, you can work on 
the first label on the sheet and even add clip art.  Then open the label window again and create another 
New Document. 
 
If you'd like to include clip art in your label, go to the Insert Ribbon, choose Clip Art, search for the desired 
clip art picture.  Place the cursor in the first label and double click on the picture.  Then resize the clip to 
your liking, right click it and Wrap Text so picture is "In front of Text". Allign it the way you want it, then go 
to the label window and create a New Document.  They should now all show the clip art. 
 
Mail Merge 
 

In doing a Mail Merge you create a general document or label that contain the column names from a 
table.  After the merge you will get a SET of documents, one entry for each line in the table.  This permits 
you to make a set of greeting card mailing labels or form letters with the name imbedded.  The 
Publisher’s Clearing House letters - addressing you by name with your address in the body of the letter 
could have been done with a mail merge.  The PebbleCreek Computer Club Membership Cards were 
done with this method. 
 
2007 and later - Mail Merge, although somewhat tricky to do, is a little easier in Word 2007 and later than 

in earlier version of Word.  It is all handled in the ribbon revealed from the Mailings Tab.  You start with 
the Start Mail Merge Section.  Here you choose the Step by Step Mail Merge Wizard.  Once you have 
mastered the terminology, the creation of the merged document is fairly straight forward. Unfortunately 
you will never master this by reading about it.  Try it.  Make a few mistakes and you will master it. 
 
Other Word Features 
 
There are so many features in Word that it is hard to touch on them all in a few lectures.  Other features 
that I have used that can be very handy are: 

 
 Inserting a symbol (Insert then Symbol) like a degree sign  or a fraction ⅓ or a Euro sign € 

 Inserting a drop capital letter at the beginning of a paragraph - see first paragraph under Help. 

 Doing a word count on a document (Review Ribbon) 

 Making unique designs using WordArt (See Question 3 the following page) 

 Tracking changes made to a document.  Changes will appear in red (Review Ribbon) 
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 Adding headers and/or footers to a document that can contain things like page numbers (Insert) 

 Adding pictures, lines, arrows and boxes using the drawing feature 

 Creating letterhead using the header record 

 Inserting tabs on the top ruler to define stops 
 
Bear in mind that if you are using a Word facsimile such as Open Office or Microsoft Works, all of these 
features may not be available. 
 
Three Questions Answered (3/4/19) 

 
Three questions about Word were asked of me this week, none of which I knew the answer to… at the 
time.  The first thing I do when that happens is to look up (through Internet Google searching) the 
answers.  None of the solutions was difficult to find so I'd like to present them below.  Two points are 
worth making here: 1) It isn't necessary to memorize every possible feature of a program as complex as 
Word and, 2) It is usually quite quick and easy to find an answer to your question on the Internet.  I first 
state the question and then its answer in Word 2010: 
 
Question: Is there a switch in Word that controls the appearance of Orphan/Widow lines?  Stated 
differently, if only one line is going to spill over to the next page, this control would make it two lines so 
there is no single or widow line. 
 
Answer: Yes.  In the Paragraph Section of the Home Ribbon, there is a small arrow in the lower right 
corner of that section.  Left click it to reveal a small window with more settings.  Under the second tab at 
the top, labeled "Line and Page Breaks", there is a section named Pagination.  Check the first line 
"Widow/Orphan Control".  This will accomplish the task and BTW it's checked by default. 
 
Question: Is there a command that will take a section of text that is written in all Capital letters and 

change the case?  
 
Answer: Yes.  This was an easy one and I'm surprised that I never had to use it before.  Highlight the 
ALL CAPS text in your document.  On the Home Ribbon find the Font Section.  Click the downward 
pointing arrow next to the symbol "Aa" and make the appropriate choice.  You can change to all lower 
case or you can ask it to do Sentence Case, which is likely the best choice.  A keyboard shortcut, namely  
Shift-F3 also allows you to toggle between lower case, sentence case and all caps.  If I haven't stated it 
before, I'll say it now, there are almost always several ways to accomplish the same thing.   
 
Question: WordArt in Word 2007 allowed you to do some interesting designs with a phrase or sentence.  

This included making text arced or wavy. Is this feature discontinued in later versions of Word?   
 
 
                               
 
 
Answer: Not gone, but changed significantly.  This is a complicated answer.  
 
 Research revealed that this exact feature was discontinued if you are working in a .docx document. (If 
you are working with a .doc document in Word 2010 the feature is unchanged from 2007) The desired 
effects from Word 2007 can still be achieved in a .docx document.  In Word 2010 it takes two steps.  To 
test this, first type a phrase such as Happy Birthday into a .docx document.  Then Highlight it.  Then on 
Insert ribbon of 2010 click on WordArt and select a text type.  This will change only the text and will not 
provide the shape that may be desired.  But notice as soon as you changed the text, a new ribbon 
appears at the top labeled Drawing Tools.  The three choices next to the text style allow you to change 
the fill color of the text, change the outline color and, most importantly change the Text Effect.  Click on 
the down arrow next to Text Effect and start playing with all the choices.  You can create many 
fascinating designs which are ideal for posters or certificates. 
   
After working with this for a little while it actually appeared to be more powerful than the limited selections 
available in Word 2007.  Remember, if you are working with Word 2010 but using the .doc format (not 
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.docx) the original WordArt choices are still available, but the new ones are not available. I do not have 
enough experience with Word 2013 or 2016 to make any statements about how they handle things. 
Confused yet? 
 
One more complication.  If you create WordArt in 2010 in a .docx file and save it as a .doc file the 
WordArt goes away.   
 
The lesson:  Don't ever try to explain why Microsoft does some things and when going from one version 

of a program to a newer version, don't expect everything to be the same. 

 
Help With Word 

 
he Help section of word can be accessed in a couple of ways.  Microsoft Word Help can be accessed 
by simply pressing the F1 key (The F1 function key opens ‘help’ in many applications).  Type a 

keyword in the index and then choose the task you are looking to get help with.  In Word 2007 and after, 
there is small white question mark in a blue circle in the upper right corner of the application that will 
access the help feature. 
 
There are a number of tutorials on the Internet.  One pretty good one can be found at 
www.baycongroup.com/wlesson0.htm.  That website also offers free lessons on Excel, PowerPoint and 
other applications.  This site deals with Word 2002 and newer.  For Word 2010 try 
https://www.youtube.com/watch?v=fUkh3yWm3d4.  Other helpful sites can be found by typing “MS Word 
20xx Help” or “MS Word 20xx Tutorial” into Google. That would get you to the exact version number you 
want. (Remember… Google can find ANYTHING… well, almost anything.)   
 
Final Thought 
.   
Remember that a Beginner Class in Word (at a community college, for example) would likely last about 
24 classroom hours.  This would be followed by another Intermediate Class of about the same length.  
Then would come the Advanced Class.  Students in such classes would have a chance to try things out 
as they learn.  I’m sure you folks realize that this is a basic exposure and that to get good at some of the 
things presented you need to practice. 
 

Dan Phelka 
535-7791 
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